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Preface 
 This manual gives the instructions for producing 360 degree 

representations of objects.  The problem is that many steps of the process take 

place simultaneously.  For example, the user may have to focus the object, adjust 

the height of the camera, refocus the object, level the camera, reset the shutter 

speed, and then take the picture.  The next time the user may only need reset 

the focus, reset the shutter speed, and take the picture.  While the instructions 

are as sequential as possible, many steps, especially Sections 8 through 11, may or 

may not follow the order depending on the shot.   

 
Equipment Used 

2 - Arri 300 Plus 300W photoflood lights 
 
2 - Lightgear Model UR32TWB Umbrella Reflectors 
 
1 – Bogen 3021 Tripod 
 
1 – Canon EOS 5D digital 35mm camera 
 
1 – Kaidan Magellan M-1000 Stage/Turntable 
 
1 – Dell Dimension Computer 
 
Adobe Bridge CS2 
 
Adobe Photoshop CS and CS2 
 
V R Worx 2.6 
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Section 1: Setting Up the Stage Area 

SETUP 
-Set the Kaidan unit on a sturdy table. 
 
-For background, use a sheet of slightly off white paper tacked to the wall. 
 
-Center the turntable with the background paper. 
 
-Ensure the turntable assembly is firmly attached.  First check the Allen screws 
holding the rod to the turntable holder and degree wheel holder.  Next, hold the 
stage rod and turn the turntable clockwise (looking down onto the table) making 
sure the bolts are tight.  Then hold the degree wheel and turn the stage rod 
clockwise (again, looking down onto the table) making sure the bolts are tight as 
well.  Grasp the edge of the turntable and wiggle it slightly to be sure that the 
assembly is tightened securely.   

 
Figure 1-1: The Overall Setup 
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-After the initial checks and setup are done, place a cloth over the turntable.  In 
this case a soft cotton t-shirt knit material was used.  The cloth was folded to 
produce a padded square to fit over the turntable. 

 
Figure 1-2: Turntable with Cover 
 
OPERATION
-Rotate the degree wheel (best) or the turntable itself CLOCKWISE to move the 
turntable.  The degree wheel moves in 10 degree increments.  Use the pointer and 
degree wheel to set start point and end point.  For example: the start point is at 
90 degrees.  For 36 images at 10 degrees each, take pictures at each click until 
the wheel reaches 90 degrees again. 
IMPORTANT: BE SURE TO ROTATE THE DEGREE WHEEL OR TURNTABLE 
CLOCKWISE AS VIEWED FROM THE TOP…SAME DIRECTION AS 
CHECKING TIGHTNESS!!!  OTHERWISE THE TABLE WILL LOOSEN AND 
THE OBJECT COULD FALL AND BE DAMAGED OR DESTROYED!!!  ALSO, 
ROTATE THE OBJECT SLOWLY AND CAREFULLY. 
 

 

Figure 1-3: The 
Degree Wheel 
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Section 2: Lighting 
 
CAUTION: The lights get VERY HOT in operation!!! 
REMOVE/REPLACE LAMP SHUTTERS 
-To install the shutters, locate the holding clip at the top of the lamp.   

 
Figure 2-1 
 
-Pull up on the clip and rotate it in either direction about ¼ turn. 

 
Figure 2-2 
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-The shutter has a groove on the rear.  Slide this groove through the other clips.  
Then lift and rotate the upper holding clip to grasp the shutter groove. 

 
Figure 2-3 
 
-Remove the shutters by pulling up and twisting the holding clip out of the way. 
-Slide the shutters out of the holding clip.  Pull up and twist the clip back to its 
original position. 
 
RAISING AND LOWERING THE LIGHTS 
-Raise and lower the lights by loosening the clamps on the light stands and 
telescoping the poles to the position desired.  Tighten the clamps at the desired 
position. 
 
TILTING THE LIGHTS 
-Loosen the clamp beside the lamp.  Tilt lamp to the desired position and tighten 
the clamp. 

 
Figure 2-4 
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INSTALLING THE REFLECTOR UMBRELLA
 
-Remove the shutters if they are in place (see Remove/Replace Lamp Shutter 
procedure).   
 
-Tilt the lights to shine upward. 
 
-Slide the tip end of the umbrella handle into the hole in the rear holder (note: 
the umbrella handle will be very loose as the hole is rather large.).  Press the 
other side into the top of the holding clip between the screw/spring and the 
edge.  This will hold the umbrella in place and allow it to slide for adjustment. 

 
Figure 2-5 
 
SETTING UP THE LIGHTING 
 
This requires some experimentation and judgment on the part of the user as 
every object reacts differently.  Ideally the lighting should illuminate the object 
while producing very soft, almost non-existent shadows.   
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Figure 2-6 
 
Depending on the object, the lights may need raised or lowered to produce the 
desired effect.   
 
Indirect lighting, with the umbrella reflectors, usually produces the softest 
shadows and more even lighting.  However, very dull, dark items may benefit with 
more direct in spite of the shadows.  The more direct lighting will illuminate the 
object better.   
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Shiny, highly polished, or glazed objects introduce a new problem.  In addition to 
the shadows and lighting quality, the shininess produces glare spots that can 
interfere with photographing the object.  Indirect lighting produces the least 
glare off shiny object.  Moving the lights will help minimize the glare as well.  
These settings will depend on the object’s shape, size, and shininess.  Note: glare 
cannot be completely eliminated, only minimized.  A small amount of glare might be 
desirable as it gives the indication the object is highly polished or glazed. 

 
Figure 2-7 
 
In this example (Fig. 2-7), note where the shiny areas are.  Try to keep the shine 
as dim and out of the front of the object as possible.  Also note the dark shadow 
in this example.  The lighting, in order to reduce glare to a minimum, necessitated 
a darker shadow.  This also exemplifies the compromises and judgment calls the 
user will have to make. 
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Section 3: Lens Mounting 
INSTALLING THE LENS 
IMPORTANT: Mount the lens as quickly as possible to prevent dust and dirt 
from entering the camera body!  Also, try to change lenses as little as 
possible to help keep dust/dirt at bay. In a digital camera, dust can collect on 
the sensor producing dark spots in the final image necessitating a complex 
cleaning procedure.  It is best not to change the lens frequently if at all possible.   
 
NOTE: The lenses were photographed upright to show how the cover operates.  
When actually doing this, DO NOT remove the cover with the lens upright.  Try to 
remove the cover with the lens horizontal, or better, with the mounting end 
facing down to keep dust out.  The best way is to sit the lens on a table, cover 
side down, hold the lens and twist the cover to loosen.  Then lift the lens out of 
the cover while the cover remains on the table. 
 
-The cover should have both red dots aligned, although the cover will fit when the 
red dots are not aligned.  So you may find the cover tightened with the dots 
aligned or not aligned.   

 
Figure 3-1 
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-In either case, give the cover a ¼ turn counterclockwise (facing the cover) to 
remove it.   

 
Figure 3-2 
 
-Also, loosen the cover on the camera body by turning it counterclockwise until 
the mark reaches 12 o’clock, but do not remove the cover yet! 
 
-With the cover side facing down, remove the lens cover. See note at beginning of 
section.   
 
-Lift lens from cover.  Remove the camera cover now.  Line up the red dot on the 
lens with the red dot on the camera body.  

 
Figure 3-3 
 
-Seat the lens by gently lowering the lens into the camera body.  It should drop 
smoothly and completely.  If not, check the alignment.   
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-Once the lens seats, gently twist the lens clockwise to lock it.   

 
Figure 3-4 
 
REMOVING THE LENS 
-Press and hold the lens locking button down while turning the lens 
counterclockwise until the lens stops. 

 
Figure 3-5 
 
-The rest of the procedure is the reverse of the mounting procedure.  Be sure to 
cap the camera body as soon as the lens is removed.   
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Section 4: Camera Mounting 
 
REMOVE THE MOUNTING PLATE FROM TRIPOD 
 
-Push the lock lever forward and turn clockwise up to hold the lock lever in place.  

 
Figure 4-1 
 
-Flip the hold down lever outward to release the plate. 

 
Figure 4-2 
 
-Lift the plate off the tripod. 
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MOUNT PLATE TO CAMERA 
 
-Turn the large gray nut counterclockwise toward the thumbscrew head.  

 
Figure 4-3 
 
-Start threading the thumbscrew (clockwise) into the camera’s mounting hole.  
Take care not to force and strip the threads on the thumbscrew or camera. 
 

 
Figure 4-4 
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-Rotate the plate until the lens arrow parallels the lens on the camera.   

 
Figure 4-5 
 
-Gently tighten the thumbscrew until it just stops. 
 
-Make sure the lens arrow on plate is parallel with the lens on the camera.  
Tighten the large gray mounting nut firmly.  DO NOT FORCE OR OVERTIGHTEN 
AS THE CAMERA MAY BE DAMAGED!!!! 

  
Figure 4-6 



   

  18 

 
PLACING CAMERA ON TRIPOD 
Aim the camera toward the front of the tripod.  Slide the left side of the hex 
into the keyed head.  The camera should drop down a bit.  Push down on the right 
edge of the camera to trip the lock.  The camera should be tightly clamped in the 
head.  Turn the lock on the front of the tripod counter-clockwise to secure (see 
Fig. 4-1).   

Figure 4-7       Figure 4-8 
 
DISMOUNTING THE CAMERA 
-Push the lock lever forward and turn clockwise up to hold the lock lever in place.  

 
Figures 4-9: Note: Camera removed for clarity. 
-Flip the hold down lever outward to release the camera. 

  

Figure 4-10: Note: Camera 
removed for clarity 

-Unscrew the thumbscrew and remove plate from camera (see Fig 4-6). 
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Section 5: Tripod Adjustments…Placement, Height, Camera Angle 
 
PLACING THE TRIPOD 
The following are approximate values.  The actual distance used gives a view of 
the whole object, allows for rotation, and contains a bit of the background when 
framed in the viewfinder.   
 
Place the tripod around 2-2.5 feet away from the object if the object is small 
(less than 1 foot in length and width).   
Place the tripod around 3-3.5 feet away from the object if the object is larger 
(about 1 foot or larger in length and width). 
   
ADJUSTING THE CAMERA HEIGHT 
 
The camera height will vary depending on the object size, mounting height, and 
desired photographing angle.  Two methods are provided to set the overall height 
of the camera.  The head has a short height adjustment, a sort of “fine 
adjustment”.  The tripod legs adjust as well, a sort of “coarse adjustment” that 
provides most of the height.   
 
-Each leg has two sets of clamps.  Starting with the lower clamps, loosen the 
clamps and extend the legs to the desired length.   

 
Figure 5-1 
-Tighten the lower set of clamps.   
 
-Spread the legs out so the tripod sits upright.   
 
-If the tripod needs to be lowered, hold the head and loosen the clamps.  Lower 
the tripod to the desired height and tighten the clamps (see Fig. 5-1). 
 
-If the tripod needs to be raised, hold the tripod head and loosen the upper 
clamps.  Raise the tripod to the desired height and tighten the clamps (see Fig. 5-
1).     
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-The clamps can be loosened and the legs adjusted individually in case the tripod 
sits on an uneven surface, the legs did not extend far enough, or the legs 
extended too far.   
 
-A finer height adjustment can be made at the camera head.  To make the 
adjustment, loosen the large clamp at the base of the head shaft.  Move the head 
up or down to the desired position.  Tighten the clamp.  (Figure 5-2) 

 
Figure 5-2 
 
-To set the angle the camera sits at, loosen the large clamp facing the user and 
tilt the camera to the desired angle (Figure 5-3).  The shot’s angle also affects 
how high the camera should be.  The user may need to raise or lower the tripod to 
get the desired shot framed.  If so, try the head height adjustment first (see 
Fig. 5-2).  If there is still not enough height, then adjust the legs (Fig. 5-1).   

 
Figure 5-3 
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-Once the camera is at the desired height and angle, the camera must be leveled.  
Look at the spirit level on the rear of the tripod.  Twist the knob on the right 
side clamp counter-clockwise to loosen.   

 
Figure 5-4 
 
Then holding this handle, move the camera side to side until the bubble lies 
between the two lines on the spirit level.   

Figure 5-5      Figure 5-6 
 
When the bubble is centered, tighten the clamp by turning the knob clockwise 
(see Fig. 5-4).  Double check to make sure the bubble is centered.  If it moved, 
then follow the procedure again.  After leveling the camera, look through the 
viewfinder to make sure the shot is still framed correctly.  Most likely the shot is 
still correct, but if not, readjust the tripod accordingly. 
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Section 6: Connecting the Remote Shutter Release 
 
-Find the rubber doors on the left side (while facing the rear) of the camera 
(opposite the flash card side). 

 
Figure 6-1 
-Open the door nearest the lens to expose the lower shutter release outlet.   

 Figure 6-2 
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-Find the remote shutter release control.   

 
Figure 6-3 
 
-Plug the control into the outlet on the camera.  The plug is keyed to fit one way.  
The cord should point to the front of the camera when correctly inserted.  
 

 
Figure 6-4
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Section 7: ISO and Camera Mode Check 
 
-To check the ISO number, press the “Drive ISO” button near the top display 
(Figure 7-1). 
 
-The ISO number will appear in the display. 

 
Figure 7-1 
 
-Set the ISO number to 1000 by rotating the thumbwheel on the rear of the 
camera. 
 

 
Figure 7-2 
 
-Once the ISO speed is set, check to make sure the camera is set to Manual 
mode.  Look on the top of the camera and make sure the “M” is under the pointer. 
(See Figure 7-1)  If not, rotate the wheel until the “M” lies under the pointer. 
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Section 8: Aperture Setting 
NOTE: The aperture on this camera is NOT set via the lens ring like a normal 
35mm film camera!  It is set in the rear on a thumbwheel. 
 
While two ways exist to observe the aperture setting, the setting is the same in 
both cases.  Set the aperture to 22. 
 
Touch the shutter release button on the camera or remote release.   

 Figure 8-1 
Look at the display on top of the camera or look through the viewfinder.  Note 
the aperture readout.   
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Figure 8-2 

Rotate the wheel on the rear of the camera clockwise to raise the aperture, or 
counter-clockwise to lower the aperture. 
 

 
Figure 8-3 
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Section 9: Focusing 
While the camera has an auto focus feature, manual focusing is better from the 
standpoint the focus can be better controlled.   
-Remove the lens cap. 
-Turn off the auto focus feature by flipping the switch on the lens to MF.   

 
Figure 9-1 
-Look through the viewfinder at the object and adjust the focus ring on lens.   

 
Figure 9-2 
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-Try to get the entire object in focus if possible.  If not, get the front of the 
object as crisp as possible and try to get the rest as good as possible.   
 
-Optionally, can check the focus by touching the aperture button (on the side of 
the lens mount below lens lock button) to see if focus changes.  The front of the 
object should remain in focus while the rear should come into focus (note: the 
image will get very dark, and this may not be possible).  Release the aperture 
button and focus somewhere in the middle of the object should the focus happen 
to get worse.  Press the aperture button again to check the focus.  Continue this 
process until the object is in focus. 
 
Focusing is as much an art as a science.  A degree of trial and error exists in the 
process.  The depth of field (the range from the lens that is in focus) is very 
shallow in this procedure.  The high aperture setting makes the aperture act like 
a “second lens” and extends the depth of field.  This is why there is some limit on 
object size.  The following images (Figs. 9-3 to 9-5) give some examples of 
focusing overall, the front, and back of a fairly long object.  
 

 
Figure 9-3 
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Figure 9-4 
 

 

Figure 9-5 



   

  30 

Section 10: Metering the Shot 
-Remove the lens cap if not all ready removed. 
-Either lightly touch the shutter release on the camera or remote release. 

 Figure 10-1 
 
-The meter scale will appear on either the camera display on the top or in the 
viewfinder (the viewfinder is much easier to see and work with).   

 
Figure 10-2 
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-There is a range from -2 to +2 with a large center mark while underneath is a 
pointer.  Meter the shutter speed so the pointer will line up with the center mark.     
 

 
Figure 10-3
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Section 11: Taking the Photo 
TAKING THE SHOT 
-After preparing the camera (metering, aperture, and location), take the picture. 
 
-Press the shutter release on the remote to take the picture.   
 
-Rotate the object the required number of degrees (see Stage Operation 
section), in this case 10 degrees.  Because of the slow shutter speeds, let the 
object stop moving for a few seconds and snap the photo. 
 
-Be sure not to contact the camera, tripod, or stage assembly when 
photographing.  The shutter speeds in this case are so low that any movement will 
be picked up by the photo as a blur.   
 
-Once the image is recorded, the actual image and other information appear on 
the LCD screen on the rear of the camera.  This screen gives information like 
picture number, aperture, shutter, ISO speed, and a very strange graph called a 
histogram.   
 

 
Figure 11-1 
 
The histogram shows how balanced the lighting, color, and object are.  This will 
vary from object to object.  Peaks on the far right side indicate glare and 
overexposure.  The user should try to keep the peaks on the far right side (see 
figure 11-1) to a minimum or preferably none.  If peaks do appear, try 
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repositioning the camera and lighting to reduce glare and overexposure.  Then try 
a test shot to see if the peaks disappear. 
 
DELETING PHOTOS FROM FLASH VIA THE CAMERA 
-The user can delete photos with the camera.  This is useful if bad shots are 
taken and the user does not want to remove the flash card. 
 
-Press the button that turns on the display (circled in Figure 11-2) 

 
Figure 11-2 
 
-Turn the thumbwheel to scroll through the pictures on the flash drive. 
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-When one to delete comes up, press the trash button. 
 

 
Figure 11-3 
 
-The delete screen will appear (Figure 11-3).  Scroll through the choices, “cancel”, 
“erase”, or “all” to highlight and press the “set” button to select.  To delete the 
current image, choose “erase”.  To erase the entire card, select “all”.  To leave 
the delete function, choose “cancel”. 
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Section 12: Download Images from Flash Card 
 

REMOVING THE CARD 
 
-IMPORTANT: TURN OFF THE CAMERA BEFORE REMOVING CARD!!!  If the 
card is removed before turning off the camera, the card can be erased or 
corrupted (Figure 12-1). 

 
Figure 12-1 
 
-The card is accessed behind a door on the shutter button side of the camera.  

 
Figure 12-2 
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-Slide door back (toward screen side) until door snaps open.  

 
Figures 12-3 
 
-Flip door open.  Find the white release button near the bottom of the card.  
Press the release button and the card partially pops out.  Slide the card out of 
slot. 

 

Figure 12-4 
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READING THE CARD 
-On the computer, go to My Computer and open the file the images will be stored 
in. 
 
-Plug the card reader into a free USB port on the computer. 

 
Figure 12-5 
 
-Plug the card into the card reader’s upper left slot (Figure 12-5).  It should slide 
almost all the way in, and then some resistance can be felt.  Gently push the card 
on in the slot (Figure 12-6).  The card is keyed and goes only one way.  Usually the 
card will be marked “TOP” or have an arrow to show how to insert it.  If not, 
insert the plug end (series of holes) first.  If the card will not go, then flip it over 
and, plug side first, try again.  DO NOT FORCE THE CARD INTO THE SLOT-the 
pins in the reader may be damaged! 
 

 
Figure 12-6 
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-After correctly inserting the card, Windows should recognize the card and open 
a window showing the files on the card. 
 
-Select (double click on) the file DCIM. 

 
Figure 12-7 

 
-Then select (double click on) the file 100EOS5D (Figure 12-8). 
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Figure 12-8 

-The file that holds the images opens.  Either select ‘Edit->Select All’ OR click on 
one image and type CTRL-A to select all the files (Figure 12-9). 

 
Figure 12-9 
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-Then right click on an image and select “Cut” or go to the main menu and select 
‘Edit->Cut’. 

 
Figure 12-10 

 
 
-Right click in the image storage folder, and select “Paste”.  The images will 
transfer from the flash card to the file on the computer’s drive. 

 
Figure 12-11 
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-After the images are loaded, close the flash card window.  Then pull the flash 
card out of the reader (see Figures 12-5 and 12-6).   
 
REINSTALLING THE CARD 
-Align the plug side (has many holes) with the slot in the camera.  Make sure the 
correct side of the card is facing you (usually the maker’s name is on this side or 
will be labeled with an arrow).  Gently slide the card into the slot.  The card will 
side easily and then some slight resistance will be encountered.  Gently push the 
card on in until it stops and the button pops out.  NOTE: DO NOT FORCE THE 
CARD IN!  If the card should stop about halfway, it is in backwards.  Slide the 
card out.  Keeping the holes turned to go in first, flip the card over and try 
sliding it in.  It should go this time.   
 

 
Figure 12-12
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Section 13: Adobe Bridge Instructions 

 
-Open Adobe Bridge. 
 

 
Figure 13-1 
 
-On the left side is the “Folders/Favorites” panel.  Click on the “Folders” tab if 
not selected.  In the “Folders” menu, navigate to the folder where the images are 
located.   
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Figure 13-2 
 
-Click on one image to highlight it (see Fig. 13-1).  Then press CTRL-A on the 
keyboard to select all the images (Fig. 13-2).  OR… 
 

 
Figure 13-3 
 
Click one image to highlight it (see Fig 13-3).  Go to the main menu and click “Edit” 
and click “Select All” in the dropdown menu. 
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Figure 13-4 
 
-Then right click on an image (Fig 13-4).  Click “Open” in the dialog box that 
appears.  OR… 
 

 
Figure 13-5 
 
Go to “File” in the main menu and select “Open” in the dialog box (Fig. 13-5). 
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Figure 13-6 
-A dialog box will open warning about opening a large number of files.  Click “OK”. 
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The white balance adjustment is next.  Bridge allows all the images to be adjusted 
simultaneously.   
 

 
Figure 13-7 
-First select the image with the calibration cards.  This image will open in the 
preview pane. 
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Figure 13-8 
-Click “Select All”. 
-Then click “Synchronize”. 
 

 
Figure 13-9 
-At the bottom of the screen, check the resolution and make sure it is set to 600 
pixels per inch. 
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Figure 13-10 
-A popup will appear asking what needs adjustment.  Select all the boxes or 
“Everything” in the dropdown menu and click “OK”. 
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Figure 13-11 
 
The next steps show how to adjust the white balance.  The box in the upper right 
(rectangle) is the histogram.  In theory, the R-G-B curves should line up exactly.  
Also, the numbers above the histogram (circled) should be exactly the same when 
checked with the standard white, black, and gray cards (e.g. white should be R: 
255 G: 255 B: 255).  In practice, this ideal is seldom if ever met.  The user can 
get close, but often the end result is not exact.  The user should try for as close 
as possible (the values within about 1-5 points of each other). 
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Figure 13-12 
-Zoom in on the object and the standard cards by clicking on the “Magnifying 
Tool” and clicking the place to zoom in on. 
 
-If the zoom missed, use the “Move Tool” to grab and move the image or hit 
CTRL-(-) on the keyboard to zoom out. 
 
-Now click on the eyedropper (Sampling) tool to sample the standard cards. 
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-Hold the tool over each of the standard cards and observe the numbers.  Most 
likely the numbers will be wrong.  The following images show examples of 
incorrect values (Figures 13-13 to 13-16)… 

13-13 
Light Gray…Note how the B is very different, and R and G are not very close. 
 

13-14 
Dark Gray…Again, the numbers are way off. 
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13-15 
Black…same story 
 

13-16 
White…again, way off 
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Figure 13-17 
-To adjust the white balance, the adjustments on the right can manually reset the 
image properties and adjust the balance.  However, the auto compensation 
features work well and only a slight touchup is needed. 
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-Go to the white balance dropdown and select “Auto”.              Fig. 13-18 
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          Fig. 13-19 
-Photoshop will adjust the curves to bring the balance to specification.   
-After the Auto Adjust is done, check against the standard cards to be sure that 
the end result is correct.  To do this, click on the eyedropper tool like before and 
hover over each of the cards and note the readings.  In this example, the cards 
came out as follows:  

13-20 
The Black card is acceptable. 
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13-21 
The White card is acceptable, but barely. 
 

13-22 
The light gray is off.   
 
-To correct the problem, click on the light gray card to reset the balance and 
check the balance on all the cards by holding the eyedropper tool over the cards 
again... 
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13-23 
The Dark Gray is great. 
 

13-24 
The Light Gray is excellent. 
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13-25 
The Black is great. 
 

13-26 
The White is excellent. 
 
 
IMPORTANT NOTE TO BALANCE ADJUSTMENTS: There is some degree of 
judgment in white balance adjustment.  While a correct white balance setting 
usually produces a good image, in some cases correct balance does not.  Different 
factors such as lighting, the camera, angle, the object, etc. may produce a less 
than ideal final image even with correct adjustment.  In this case, the user may 
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want to try one of the other White Balance settings (like Tungsten, Fluorescent, 
Daylight, etc.) or try the manual adjustments to attempt to correct to a lifelike 
rendering.  In some cases, such as no hope of adjustment or the object looks good 
and the background looks weird, something went wrong.  The sequence should be 
retaken.  In the end, the object in the image should be rendered like the object 
in real life.   
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13-27 
 
-To save the images click “Save x Images” (where x is the number of images 
opened).    
 

13-28 
 
-Click on the arrowhead to open and choose either “Save in New Location” or if 
the same folder is being used, “Save in Same Location”.   If saving in the same 
folder skip the next steps, otherwise, click on “Select Folder”. 
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13-29 
 
-The “Select Destination Folder” opens.  Select the folder to save the images in 
from the file tree.   
 
-If the file has not been created, use “Make New Folder” to create a new folder.  
Click on the folder you want the new folder placed in and click “Make New Folder”.  
A new folder will be created.  Name the folder and click away from the folder or 
hit ENTER on the keyboard to finish.   
 
-Click on the desired folder and make sure it is highlighted.  Then click “Select”.   
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13-30 
 
-When the desired folder is selected, the Save screen reappears.  Bridge allows a 
great deal of latitude in naming images.  In the first box a name, number, or one 
of the dropdown options (like date, serial number, number, etc.) may be chosen.  
 

13-31 
-The same goes for the other three boxes.  In this case, the images will be named 
simon, simon_1, simon_2, etc. as Bridge names them in sequential order.  Then 
select the “File Extension” as a .TIF to save as a TIFF file. 
 
-Click “Save”. 
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13-32 
 
-The save status pops up just above the save button.  This little line will tell how 
many images are left to save.  NOTE: It will take as long as 5-15 minutes to save 
the images.   
 
-When finished, the line will disappear. 
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13-33 
-Click “Done” to exit. 
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Section 14: Using Photoshop to Convert Tiff’s to Jpeg’s for  
Rotation  

 
 

Coming Soon…
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Section 15: VR Worx Operation 

 
-Open VR Worx.  The welcome screen appears. 
 

 
Figure 15-1 
-Select “Create an Object” and click “OK”.  The object dialog box will appear. 
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-The “Setup” tab should be active, if not, click on the “Setup” tab.   

 
Figure 15-2 
 
This page sets the number of images, the sweep angle (vertical and horizontal), 
and the number of images in the horizontal (around the object) and vertical (over 
or under the object) planes.  Use the default settings as shown.   
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-After the initial setup, click the “Acquire” tab.  This will open the image loading 
dialog box.  Once the “Acquire” box is open, click on the “Multiple” tab to begin 
loading the images. 
 

 
Figure 15-3 
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-The “Import Images” dialog box opens.  If the folder containing the images does 
not appear, then click on the “Look In” arrow and navigate to the images’ file (in 
this case, the 360 file on the Arrowmont drive M:).  Click on the file to open. 
 

 
Figure 15-4 
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Figure 15-5 
 
-From the list, select the desired images [rectangle].  If the images are in 
sequential order, merely select (highlight) the first image and scroll to the last 
image, press “Shift” and then click on the image.  **CAUTION: BE SURE the 
images are named in sequential order like 1, 2, 3… or alphabetically from first to 
last.  If not, the images will be out of sequence in the final build**  Once the 
desired images are selected, click the “Add” button.  The images are added to the 
lower list 
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Figure 15-6 
-Scroll through the list of images to double check the images are in sequential 
order.  If an undesired image is found, highlight the image and click “Remove”.  
When satisfied 36 desired images are loaded, click “Done”. 
 

Fig. 15-7 
-The images loading (Fig. 15-7). 
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Figure 15-8 
 
-After the images load, scroll through images (arrows) and make sure order is 
correct.  There should be some appearance of movement as images are scrolled. 
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Figure 15-9 
 
-When the images load, click on the “Compose” tab.  Check the settings.  The 
settings should be set to the default settings.  Once verified, click the “Build” 
button.  VR Worx will build the animation. 
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Figure 15-10 
 
-Click on the “Preview” tab to open the preview window.  Try the animation here to 
see if it works properly.  To check the animation, move the cursor anywhere over 
the object.  A hand will appear.  Left click and hold the left mouse button.  The 
hand will appear to “grip” the object.  Move the mouse to the left and right to 
rotate the object.   
 
-Misaligned images will show here.  The object will appear to wobble when moved.  
If this is the case, go back to Photoshop and try to realign the images and start 
over with a new animation.   
 
-If an image is out of sequence, the animation will act strange.  If so, go back and 
rename the image so it falls into correct sequence.  The animation will have to be 
rebuilt and re-composed.   
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Figure 15-11 
 
-Another problem that may occur is that the image will rotate in the opposite 
direction of the scrolling.  This is very confusing for the user and must be 
corrected.   
 
To correct this problem, first click on the “Interaction” button.  The “Object 
Interaction” dialog box will open.  To make the scroll directions match, check the 
box “Reverse pan direction” and click “OK”. 
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Figure 15-12 
 
-Users often do not realize that the object may be moved.  It is a good idea to 
set the animation so the object will start rotating when opened.  To animate the 
object, click the “Animation” button.  The “Animation Settings” dialog box 
appears.  In the dialog box under View Animation, check “Enabled” and set the 
speed.  Set speed to one notch above Normal.  Click “OK”. 
 
The object will begin rotating.  Check again to see that it rotates smoothly.  Then 
take the cursor and just like before, grab the object and move it manually making 
sure it moves smoothly and moves in the same direction as the mouse. 
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Figure 15-13 
 
-To save the movie, click on “Export”.  This will open the “Export” dialog box.  
Navigate to the desired folder.  Enter the movie’s name in the “File Name” box 
and click “Save”.  The movie is complete.   
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Figure 15-14 
 
-It is a good idea to check the movie in Quick Time to ensure everything works 
properly.  Navigate to the file and open with Quick Time. 
 
-When finished, close out VR Worx by clicking on the red x in the upper right 
hand corner or by selecting File->Exit from the main menu.  A prompt asking to 
save the raw work may appear.  Unless a change to the movie might happen later, 
there is no need to keep the file.  Click “No”. 
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